
Creating racing drones in Fusing 360 to Flow Design 

The Step by Step Insider Guide walks readers through basic to advanced drone airframe 
aerodynamics. Your creative results may vary, experimentation is encouraged. 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PD21100-L 

Racing-Drone Design Fundamentals with Fusion 360 
ELI DElia - Eagle Eye 

Taylor Stein - Autodesk 
 

Description 
Professional drone racing is now and the market is hungry for new dynamic 
designs to feed the sport! This class will go in depth with Fusion 360 software in 
tandem with Flow Design wind-tunnel simulator to demystify the working 
fundamentals of mainstream racing drones. Attendees will learn essential steps 
in creating a CAM (computer-aided manufacturing)-ready, aerodynamic airframe 
around imported component files. This session features Fusion 360 and Flow 
Design. 

LEVEL OF EXPERTISE:
All Levels

PREREQUISITE SKILLS OR KNOWLEDGE:
Fusion 360

PRODUCT :
Fusion 360, Flow Design Wind Tunnel Simulator

Your AU Expert(s) 
Taylor Stein, Fusion 360 Evangelist  
Bryce Heventhal, Technical Marketing Manager for Fusion 360 
Paul Sohi, Autodesk Product designer 
Mickey Wake Field, Autodesk CAD and Simulation software manager 
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Learning Objectives 
• Learn best practices and workflows for creating an aerodynamic racing 

drone 
• Understand airframes and power-trains layouts—learn how to build 

airframes around imported component files 
• Learn how to use Flow Design wind-tunnel simulator to guide UAV form 



 

About the Speaker: 
Commercial Drone Designer, Fusion360 Expert Elite. 
Founder of Game of Drones and Aerial Sports League. Owner 
Hooligan FPV Pro Racing Drones. Eagle Eye Metrics, Aerial 
Agronomy & Services.  
Eli has a number of  sports drones in the market. Has been 
involved with fringe robotics since 1996. Now exclusively in the 
commercial drone industry as a designer, engineer and certified 
FAA Pilot in Command. 
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http://www.hooliganfpv.com
http://www.eagleeyemetrics.com


Section 1 - Modeling A Basic Airframe   

Step 1: Creating The Motor Component Plate - Motor Mounts: 

 
1. Launch Fusion 360


2. In the Model Module / Sketch Menu / Create New Sketch. 
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3. Select the bottom plane so your view orientation is facing down.


4. Sketch / Center Diameter Circle. From world center draft a 210 millimeter circle. 
Drag out and input 210 mm in the diameter dialog box.


5. Sketch / Line Tool. Draft a vertical line from center to just past the top of the circle 
perimeter and hit “X” on your keyboard to convert the line to a construction line. 


6. Sketch / Line Tool. Draft out a horizontal line from center to just past the right of the 
circle perimeter and hit “X” on your keyboard to convert the line to a construction line.


7. Measure out a 45 degree arc from the center vertical and horizontal lines. 
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8. Sketch / Line Tool. Draft another line tool between the two and type in 45 degrees. 
Hit “X” on your keyboard to convert the line to a construction line.


�

� 


9. Select the Circle and hit “X” on your keyboard to convert the line to a construction 
circle.


Note: When drafting out a Motor Mount it is key is to assure that the motors are 
equal distance or square from each other. 
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10. Create the motor mount, Sketch / Center Diameter Circle. From the 45 degree line 
intersection draft out a new construction circle and input 25mm. (almost 1 inch) 


� 


11. Use the 25mm dimension line as a guide, adjust so it is perfectly vertical. 


12. Create a center circle which will become a hole to allow the motor’s drive shaft to 
spin freely. 


13. Sketch / Center Diameter Circle. From motor mount circle center draft out a new 
circle and type in 5mm.


� 
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14. Sketch / Center to Center Slot tool. Using the 25mm dimension line as a guide, 
draft a slot just off the center motor shaft circle. Type in 4mm in width.


� 


15. Adjust the top and bottom arcs to allow distance from the top circle perimeter and 
the cent circle diameter.

 


� 
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16. Right drag select the motor mount slot.


17. Sketch / Circular Pattern Tool. From the tool’s dialogue box check to be sure all 11 
elements of the slot tool are selected. Click on center point and select the motor mount 
circle center point. 


� 


18. Change the default setting from 3 to 4 and click ok.


� 
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19. The 1st motor mount is now complete with a motor screw layout to allow good wire 
flow from the motors to drone center where they will connect to the Power Distribution 
Board (PDB).


� 


20. Right drag select the complete motor mount.
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21. Sketch / Circular Pattern Tool. From the tool’s dialogue box check to be sure all 48 
elements are selected. click on Drone Center Point, change the default setting from 3 
to 4 and click ok. 


� 


� 
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� 

- The result will be motor mounts that are perfectly square.


Step 2: Creating The Motor Component Plate - Component Plate and Motor 
Booms: 

1. Sketch / Center Rectangle tool. From drone center draft a rectangle, type in the 
values of 160mm vertical by 45mm horizontal. click ok


� 
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2. Sketch / 3 Point Arc tool. From upper left Motor Mount, in line center with the 
bottom slot tool, draft a 3 point arc down to the bottom left motor mount, in line center 
with it’s top slot tool, click and drag the arc to just touch the center component plate 
rectangle.


� 


3. Repeat the process for the right side. 

4. For top and bottom arcs use the circle construction line as a guide. Draft a new arc 
from top left motor mount to the correspond position of the top right motor mount and 
drag the arc in to the center rectangle as illustrated. 
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5. Repeat the process for the bottom arc to complete the motor boom layout.


6. To add more creative control over your design it is good practice to now Tangent 
Constrain the arc tool points to their motor mounts.

7. Select an arc tool, from the Sketch Pallet click on Tangent Constraint and select a 
motor mount. Repeat the process for all remaining arcs by re-selecting the arc / 
tangent constraint, select the corresponding motor mount.

8. You may have to adjust your arc. Click the arc and drag it to the original position. 
Tangent Constraint allows the center to move independently of the top and bottom arc 
points, resulting in more fidelity of your design. 


9. As a rule the motor booms width should not be much more than the propellers, for a 
racer of this size that equals 12mm.
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Step 3: Creating The Motor Component Plate - PDB and Stand Off Hardware 
holes:


Drafting the Power Distribution Board hardware holes:

1. Sketch / Center Rectangle Tool. From drone center draft out a square and type in the 
values 30.5mm x 30.5mm, click ok. 

2. Select the lines of the rectangle and hit X on your keyboard to make a construction 
square. 

3. Sketch / Center Diameter Circle Tool. From the corner of the construction square, 
draft out a 4mm circle. Click ok. right drag select the new circle. 

4. Sketch / Rectangle Pattern Tool. 

5. Select the horizontal arrow handle and type in a value of -30.5mm. Set the quantity 
value to 2. Select the vertical arrow handle and input a value of 30.5mm x a quantity of 
2. hit return to complete the process. 
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Repeat the process for the stand off hardware holes: 

6. Sketch / Center Rectangle Tool. From drone center draft out a square and type in the 
values 145mm x 45mm, click ok. 

7. Select the lines of the rectangle and hit X on your keyboard to make a construction 
square. 


8. Sketch / Center Diameter Circle Tool. From the corner of the construction square, 
draft out a 4mm circle. Click ok. right drag select the new circle. 


9. Sketch / Rectangle Pattern Tool. 


10. Select the horizontal arrow handle and type in a value of -45mm. Set the quantity 
value to 2. Select the vertical arrow handle and input a value of 145mm x a quantity of 
4. hit return to complete the process.


-This completes the basic sketch for the Motor Component plate. 


11. Next extrude the plate to create geometry. Adjust the view by click and dragging 
the View Cube. 


12. Modify / Press Pull Tool. Or Q on your keyboard. 
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13. Select the Motor component plate. The selected elements will turn blue. Avoid 
selecting any hardware holes. 


� 


14. In the Press Pull Dialogue box enter a value of 3mm, click ok.


� 
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Step 4: Round off the corners and hard edges: 

� 




1. Modify / Fillet 
tool or use hot key 
F. Zoom into the 
sharp corner where 
the Motor Booms 
meet the 
Component Plate. 


2. Select each 
corner of the 
airframe. 
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3. In the Fillet Dialogue box enter a value of 5mm. Click ok to complete the process. 




4. Repeat the process 
rounding out the 
component plate’s sharp 
edges. 


5. Hit Hot Key F and select 
all four corners of the 
component plate, in the 
dialogue box enter a value 
of 5mm. Click ok to 
complete the process.





Note: It is crucial to round 
off any sharp edges with 
a fillet of 5mm in order to 
add significant strength 
and durability to an 
airframe. Sharp corners 
and edges create 
potential breaking points 
in a harsh crash. Crashing 
is unavoidable in drone 
sports so take steps in 
the design stage to 
increase your airframe's 
longevity.


Page !20



Step 5: Creating the Top Component Plate:

In the Browser Hierarchy Menu / Sketch, Right click the sketch and select Edit Sketch.


FPV Camera Bracket Slots:

1. Sketch / Center Point Slot Tool. 

2. In the center forward section of the 
airframe use the construction guide 
lines to draft out a Center Point Slot. 
Input a value of 1.5mm. Hit return.

Battery Strap Slots:

3. Sketch / Center Point Slot Tool. 

4. Using the construction lines on the 
right, center frame, draft out the center 
slot tool and make the thickness value 
2mm.

5. Adjust the length to be 30mm. using 
the Center Slot control line adjust it so 
the center point rests on the airframe’s 
center construction line. Be sure to 
give it enough room from the the edge 
and away from the screw holes.


6. Right drag select the new slot tool. 

7. Sketch / Rectangle Pattern tool. Select and drag the horizontal arrow handle into the 
airframe. In the Rectangle Pattern Tool dialogue box, enter a value of -39.5 and a 
quantity of 2. 

8. Select the vertical arrow handle, drag down and enter a value of -50 and a quantity 
of 2. Click OK to complete the process.

FPV antenna hole:

9. Sketch / Center Diameter Circle Tool.

10. In the rear section of the airframe, from center of the construction guide line. Drag 
and enter a value of 6mm. Return to end the process.

Cut in additional holes to reduce airframe mass:

11. Sketch / Center Rectangle Tool. 

12. From airframe forward center, draft a rectangle and enter the values of 25mm x 
25mm. Hit enter to complete the process. 

13. Right Drag select the new square. 

14. Sketch / Rectangle Pattern Tool.

15. Using the vertical arrow handle drag and enter a distance value of -100mm with a 
quantity count of 3. Hit return to end the process. 


This completes the Top Component Plate sketch. Use the View Cube to adjust your 
view to a perspective. 
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16. Modify / Press Pull Tool or hit hot key Q.


17. Select the new component plate sections. Extrude to a value of 1.5mm in the 
dialogue box, hit return to complete the process to create the new geometry. 


� 


18. Browser Hierarchy / open the Bodies menu and select Body #2.


� 
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19. Modify / Move Tool. Drag the new body geometry up to a value of 25mm.


� 


Round out the sharp edges:

20. Modify / Fillet Tool. 

21. Select all 4 corners of the new component plate’s perimeter. In the Fillet Tool 
dialogue box enter a value of 5mm, click ok.


22. Repeat the process for the corners of the square within the Top Component Plate 
w/ a Fillet radios of 5mm.
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Step 6: FPV Camera Bracket Slot and making revisions without modeling new 
geometry: 



1. Browser Hierarchy / Sketches, click the light 
bulb to make the sketch visible. 


2. Use the View Cube to orientate the window to 
view the sketch looking up words the bottom 
forward of the airframe. 


3. Modify / Press Pull Tool or Hot Key Q. 


� 


4. Select the forward FPV Camera Bracket slot and drag up so a red ghosted slot cuts 
through the bottom airframe. Hit Return to complete the process.


Modifying the model’s geometry 

The bottom Motor Component plate is now complete however there may be feature 
you wish to add or adjust to your airframe design. This is a very simple process to 
accomplish. By simply modifying the sketch your geometry will update accordingly. For 
this example adjust the FPV Bracket Slot from one long slot down to two short slots.


5. Browser Hierarchy / Sketches / Sketch1 right click Edit Sketch. 
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6. Select the forward most line of the FPV 
Camera Bracket slot and hit hot key D to 
Dimension the slot. Drag out the Dimension 
box and enter a value of 6mm and hit enter. 
The slot then updates in size. 


   � 

7. Right drag select the slot.


�       � 
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8. Sketch / Rectangle Pattern Tool. Select and drag the horizontal arrow handle and 
enter a value of -15mm and a quantity value of 2. hit return to complete the process. 


9. Stop Sketch. Notice how the model has 
updated with the new, modified slot. 


10. Use the View Cube to orientate the 
perspective looking up from the sketch. 


11. Hit Hot key Q and drag out the new slot so it cuts through both top and bottom 
plates. Hit return to complete the process.
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Resulting in two new camera mount slots. 


� 


Step 7: First Person Video (FPV) Camera Bracket:


1. From the Browser Hierarchy turn off the light bulb icons for the geometry. 


2. Sketch / Create New Sketch. Select the Forward view Plane. 



3. Sketch / Center 
Rectangle Tool. 


4. From world center 
click and drag out then 
enter a value of 
23.614mm x 27.014, 
hit return. 
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5. Sketch / Center Diameter Circle.


6. From rectangle center, drag out and enter a value of 16.789mm. 





7. Sketch / Center Rectangle 
Tool. 


8. From the top center of the 
rectangle click and drag out, 
enter a value of 4mm tall x 
10.16mm wide.


9. Repeat this process for the 
bottom center of the rectangle
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10. Sketch / Two Point Rectangle Tool. 


11. From the top right corner click, drag out and enter values 

2mm x 3.58mm hit return. 


12. Repeat for the remaining three corners. 
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13. Sketch / Center Rectangle Tool. 


14. From top center of the rectangle drag out so it cuts through bot the top rectangle 
and center diameter circle, tab down and enter a value of 3mm. Hit return to complete. 




15. Hit Hot Key Q for the Press Pull Tool. Select the new Bracket sketch drag and enter 
a value of 1.5mm. Hit return to complete.
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16. From Browser Hierarchy select the new bracket body.

17. Modify / Move Tool.


18. Drag the new Bracket into place so it fits into the top and bottom plate bracket 
slots. Adjust geometry to fit.


� 

Step 8: The airframe is done!


Your new 210mm “H” FPV Racing frame design is complete and ready for CAM or 3D 
printing. Be sure to save your work! 


For 3D printing select a frame body model and click the Make menu button / 3D Print 
to send it to your 3D Printer's set up software or Autodesk's Meshmixer. Repeat this 
process until all 3 airframe parts are ready to print.
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http://www.meshmixer.com/


Section 2. Combine the build. 


Download the “210H Components” file here. and add it to your Fusion360 Drone Racer 
Database. Use this file to study the drone’s power train, wiring and video components. 
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http://a360.co/2fgfJIO


Combine the drone files.  

Be sure to save your new airframe model into a Fusion 360 Database.

Close out the air frame model and create a new file.


From the Fusion 360 Data Panel right click on the “210H Components" file and select 

Insert into current design. 


Repeat the process for the 210H Airframe

After a moment the components file will merge with the airframe file to look close to 
this. 


From the hierarchy tree, expand the airframe so all components are visible. 

Select “210H Components” then drag and drop onto the top “210H Airframe”.


This merges to the two model files into one manageable hierarchy tree. 

Select the top of the 210H Airframe Tree so the entire drone is selected.


Rt Click / Save STL /Save the file to a folder on your desktop.
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Section 3:  Flow Design Wind Tunnel Simulation and Iteration  

1) Start Flow Design, Import / Local / Select the model .STL / click open
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2) The model will import at an odd angle. The simulator starts automatically and cannot 
be paused or stopped while adjusting the file for simulation. 


3) Tool bar / Orientation / Orientation dialogue box / adjust the Z angle slider to 90 / Y 
Angle to 90 / OK. 
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4) In the top tool bar / Click the blank box icon / Tunnel Bounds.  

Use the blue handle arrows to fully encompass the drone model. Be sure to drop the 
floor well below the drone's motor plate simulating altitude. Adjust the bounding box 
so the drone sit in the center.  


5) Use the right side view tool bar to pan, pivot and zoom to your preferred view.
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Here it’s easy to determine this drone airframe has a flow state with no turbulence at 
the tail end. Unfortunately racing drones pitch forward by 30º and more at speed. 

For a more accurate representation you will need to pitch the model. 


In the model tool bar select Orientation and set the Y Angle (deg) slider to 60º.


In 2D mode the wind 
simulation is confined to a 
vertical plane. Adjust the 
plane position with the ball 
slider on the bottom left of 
the UI to the center section 
of the drone. 


The Flow Design interface is overly simplistic with most of it’s more powerful features 
buried in the combinations of sections within the spartan toolbar.  Take to explore and 
note these features. It’s wise practice to then Export your simulation to your work 
folder as a means of saving your preferences. 
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The dark mode interface is easy to see wind flow effects.


In the top menu, click the box icon with a few little colored boxes inside it / click Dark. 
The simulation window will instantly change to dark and the wind force will be brightly 
illustrated. 


Section 4: Aerodynamic Racing Drone Design. 


Taking what was observed in the wind tunnel simulation, switch back over to Fusion 
and open the X 210 drone file.  The drone’s core electronics can be configured in a 
number of combinations to improve power to weight ratios in line with the build’s 
center of gravity. 

Re configure the airframe’s layout and electronics considering Flow Design’s wind force 
effects, reducing drag and turbulence on the drone’s angle of attack. 


Beginning with the airframe Hide the FPV components in the 
browser, then rotate or pitch the motor plate by 30º. 
Work out a Layout so the drone’s battery pack in the 
rear, center and level flight controller aligned with 
the receiver and fpv camera components are 
level and center to the x axis as illustrated 
below.
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Side and front views. Motor plate and components pitched to 30º. Center of Gravity is
balanced between the forward camera and the rear battery pack. 
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When Happy with your layout, enter T-Spline Sculpt Module to build out a monocoque 
hull. Create / Create Form.


Offset Construction Planes. 

Next set up 3 
construction 
planes 
starting from 
camera grip 
face, center 
back plate of 
the receiver, 
and another 
from the same 
receiver back 
plate, drag 
the 
construction 
plane the rear 
just past the 
battery as 
illustrated 
below. 
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Create the Offset Construction Plane Loft tool guides


From the drone’s front, resize each 
plane so they fit the fuselage 
comfortable within.
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Create the basic fuselage mesh with the Loft tool. 


In the browser tree, hide the drone’s 
geometry by clicking the lightbulb at the 
model’s top level.  


From the Sketch menu select the Center 
Diameter Square. Select the first 
construction plane’s center point, drag out a 
circle to the border of the plane. Select Stop 

Sketch from the Sketch Pallet. 


Repeat the steps for the center 
construction plane then stop sketch again. 


Last select Center Diameter Circle from 
the Sketch menu and drag out to the 
border of the last , most rear construction 

plane and select Stop Sketch. 
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In the Browser, right click the front Center Diameter Square sketch and select Edit 
Sketch. Choose the Fillet 
tool from the Sketch 
menu and click each of 
the square’s border lines 
clockwise until the entire 
square is rounded off. 
Enter a value of 10 in the 
Fillet dialogue box and hit 
OK. 


Repeat these steps for the 
center square sketch. 


Lofting the Fuselage 

From the Sculpt module, select Create / Loft. Click each sketch profile in order from 
front to back.
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In the Loft dialogue box / Width Spacing, enter a value of 8 and click OK. 


Now close and hide the Sketch and Construction Plane trees in the Browser. 


Show and expand the the X-210 model tree, 
then hide the “Components" branch. 
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Shift select the faces of the left half of the lofted fuselage model and hit Delete on your 
keyboard so only half of the model remains. 


Motor Mounts 

From the Create menu, select the Cylinder tool. 
Select the “ghosted” angled motor plate. From 
the back motor mount hover over the center 
hole and click and drag to create a cylinder. 
Enter a value of 31mm and hit return.


Repeat the process for the forward 
right motor mount. 
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Creating the Motor Booms 

Next edit the new motor mount cylinders to best match the topography of the fuselage 
model for a clean Bridge connection. 


Start by Double tap 
selecting the center 
horizontal ring and two 
vertical splines that 
face the fuselage 
model and delete 
them. 


Select the resulting face. In the Create menu, select the Extrude tool.  
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Drag extrude the face approximately 17mm. and hit return.  

Select the extrusion’s resulting center top and bottom lines and the face and hit delete. 


Repeat these steps for the other motor mount cylinder. 
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With the Modify / Manipulator tool, select both motor mount cylinders and adjust their 
position from resting on top of the motor plate so they line up center to the height of 
the motor plate.


Often the fuselage topography will need to be “cleaned up” before Bridging the motor 
mounts to the main mesh. 


Double click each 
of the fuselage 
splines, from the 
Modify menu 
select the 
Manipulator tool 
and scale the line 
to 0 in X, 
horizontally and Z, 
vertically.  Repeat 
for each of the 
body splines until 
the mesh is 
squared off.
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Next add edges to support the shape continuity when . Select an edge, Modify menu,  
select the Insert Edge tool and add horizontal spline to the top and bottom corners of 
the fuselage mesh. 


Bridging the motor booms.  The bridge tool works best at “close range”.


For this operation, the Manipulator 
tool and the Edit Form Manipulator 
tool are key.





Select the extruded end face 
of the motor cylinders and 
delete it.
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Use the underlying “ghost” 
geometry as a guide, While 
holding down the Option key 
on the Mac, Alt key on the 
PC, drag the selected end to 
the center of the “ghosted” 
motor boom.


Keep the new extruded 
geometry in line, while 
adjusting the shape by shape 
to match.  





Next select the matching face on the 
fuselage geometry and delete it.  


Prepare the fuselage mesh to connect to 
the motor boom.  Modify / Form Edit tool, 
double click the edges on the new 

fuselage hole. Hold down the option / alt 
key and drag out towards the motor 
mount boom a few millimeters.
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With the Form Edit Tool rotate to angle the fuselage connection sleeve towards the 
motor boom.


Bridge Motor booms to the Fuselage.  

The motor boom is ready to be Bridged 
to the fuselage mesh. 


From the Modify menu, select the Bridge 
tool. 


In the Bridge dialogue box, click the 
Step One arrow icon then double click 
the motor boom’s open edge. 


Click Side Two then double click 
fuselage connection sleeve edge. Select the Preview check box. The two arrows halite 
the flow of the topography. Click OK to create the Bridge and join the two models into 
a single mesh.
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Rotate the view to inspect the resulting blend connection. Repeat the bridging steps to 
the other motor mount.


With the Edit Form Manipulator, inspect the bridge mesh at the connection to the 
fuselage. Constantly adjust the resulting model to work with the underlying geometry.
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Continue shaping the mesh working towards a profile conducive to aerodynamics. 


Mirror Duplicate The Results. 
Symmetry menu / Mirror duplicate the drone body using a Construction or Origin Z axis 

plane off of model center. 
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In the Mirror Duplicate dialogue box, select the 1st select the T-Spline mesh, then the Z 
axis plane. Select OK.


The geometry is mirrored with 
symmetrical modeling active. 


Often the center top and bottom 
splines will need to be cleaned up 
and joined together. The best 
approach is to simply delete the 
center spline and connect the two 
half withe the Bridge tool. 
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From Modify menu, select the Bridge tool dialogue box, select Side one top open 
spline, then side two.  With preview active, the white arrows will show the direction of 
the resulting topography. Both arrows must point in the same direction for usable 
results.





Repeat the Bridge tool procedure for 
the bottom half. The The resulting 
model has clean, easy 

to work topography. 
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Don’t worry to much about the minor shift in center observed when toggling 
components on and off in the browser tree as they can be easily adjusted when T-
Spline model is ultimately finished. 


In the Browser unhide the 210-X tree and continue to shape the T-Spline mesh to 
accommodate the components volume. Keep in mind that underlying airframe will be 
later re-drafted, most of the power train electronics will be repositioned in favor of the


new T-Spline monocoque frame. 


The rear battery bay and the 
forward sports camera placement 
will both balance the craft and 
dramatically define the model’s 
overall shape.


Flow Design results and the 
layout of the internal components 
still allow for imagination it’s say 
over the model’s aesthetics. 
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Finishing the T-Spline Racing Drone.  

Now focus on the forward camera port. Using the Edit Form Manipulator tool, double 
click the open camera port splines so they are hi-lighted as a blue ring. Select the very 

center of the Manipulator tool for 
global scaling. Hold down the 
option / alt key to extrude scale a 
new faces around the camera lens.


Toggling the electronics Browser tree 
on and off to aid visualization.
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Repeat the process for the rear open port. It’s up to the individual to have the final say 
weather or not to leave the rear port open or close it off with the Fill Hole tool from the 
Modify menu. 


Close off the bottoms of the motor mounts with Modify menu / Fill Hole tool. In the 
dialogue box select the edge to close and Fill Star in the Fill Hole Mode.
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Use the Modify menu / Flatten tool to level off and 
make surfaces uniform. Leaving the dialogue box 
settings to default is usually best. 


When active, the model’s vertices are shown. Click 
each vertex of the surface you wish to flatten. 
Clicking the vertex again will deactivate that point. 
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Crease Tool. Adding a top access port lid. 


Just few more 
features to add 
before the model 
is ready to go 
another round in 
Flow Design.





Add hard surface 
features that can be 
made into the crafts 
main access lid using 
the Modify menu / 
Crease tool. 
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When activated the model will turn yellow. Systematically select the top splines of the 
hull. With model symmetry active you only need do one side of the model. 


The results are ready to become the 
access port lid.


Use the Modify menu / Un-Merge Edge 
tool and again select the creased 
edges. A new body T-Spline body will 
appear in the Browser tree. 
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Use the Edit Form 
Manipulator tool to move 
and adjust the new door 
open. 





Un hide 210-X components to inspect the final 
before sending it into Flow Design. 


When satisfied click Finish Form, last right button option in the  in the Sculpt Menu. 
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Add a Carbon Fiber Material  

Lastly add a material to the model by hitting A on the 
keyboard or Modify Menu / Appearance.


From the Appearance dialogue box scroll to the 
folder called “Other” / Carbon Fiber. Download, drag 
and drop the “Carbon Fiber Twill” material directly 
onto the done model.
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Back to Flow Design 

SAVE YOUR WORK!!!


Now it’s time to test the new model’s surface 
features in the wind tunnel simulator!


To recap the process. Right click the very top of the 
browser tree and select Save as STL.  Save to your 
project folder.


Next minimize / hide Fusion360 then open Flow 
Design. Import and orientate the new model.


With the new aerodynamic monocoque airframe Flow Design results are dramatically 
improved. 
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Flow Design in tandem with Fusion 360 is a powerful combination in producing next 
generation of “super” drone racers. The goal is to modify the basic build by visualizing 
wind current force effects against the model in order to iterate flight vibration 
turbulence out of the drone’s design.





For the continued learning video versions of the lessons in this guide please subscribe 
to my YouTube Channel 


Download and study the 210-X Racing Drone Fusion360 file. 
Accurate wiring and layout 
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https://youtu.be/gvv_6T32InI
http://www.apple.com


Here is a complete racing drone parts and components list: 

Drone Power train:

	 •	 4 x 2204 / 2100 kv Motors by RCManChild

	 •	 4 x 22 Amp RCManChild ESCs

	 •	 Power Distribution board w/ built in BEC

	 •	 Naze32 Flight controller w/ "Borris B." firmware programmed on Clean Flight.

	 •	 Orange 6channel RC

	 •	 FPV kit (Camera, 5.8gHz Transmitter, Antenna)

	 •	 Turnigy 3cell, 1800 Lipo Battery.


Additional Drone Hardware:

	 •	 8 x 25mm Standoffs

	 •	 32 x 3m x 6mm button head screws

	 •	 3M double sided tape

	 •	 Velcro Straps

	 •	 Zip Ties


Pilot:

	 •	 FatShark FPV Goggles

	 •	 Orange 6 Channel Radio Controller

	 •	 Lipo Battery Charger

	 •	 Metric tool kit

	 •	 Drone Back Pack


For more check out www.eagleeyemetrics.com and www.Hooliganfpv.com




I do hope this guide was effective and you find great value from it’s contents. 

To share your drone builds, get feedback and questions answered email me at 
dsfx@mac.com. 


For announcements, news and updates, please follow me on Twitter: @El7ias

Hope to see you at the races! 

	 	 	  - Eli DElia
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http://www.buildrcdrones.com/store/p84/RCMC_2204_2100KV.html
http://www.buildrcdrones.com/store/p96/RCMC_22Amp_BLHeli_ESC.html
http://www.buildrcdrones.com/store/p50/Power_Distribution_Board_with_built_in_Voltage_Regulators.html
http://www.buildrcdrones.com/store/p80/Naze32_Rev6%2C_90_degree_pins.html
http://www.hobbyking.com/hobbyking/store/__11965__OrangeRx_R610_Spektrum_DSM2_6Ch_2_4Ghz_Receiver_w_Sat_Port_.html
http://www.amainhobbies.com/rc-drones/rctimer-elgae-fov127-fpv200-camera-transmitter-set-w-lt200-v650-fpv-rtu-cable-32ch-sma-rtrfov127-sma/p449377?gclid=CjwKEAjwlfO3BRDR4Pj_u-iO2U0SJAD88y1S0m47m2n3vXz0vrqGkBhSKZiey0QCQl9XJWmXzOHpZhoClXvw_wcB
http://www.hobbyking.com/hobbyking/store/__21772__Turnigy_1800mAh_2S_30C_Lipo_Pack_US_Warehouse_.html
https://www.multirotorsuperstore.com/accessories/standoff-spacers/nylon-standoffs/black-nylon-standoff-female-female.html
http://www.amazon.com/dp/B00UWR6CWQ?psc=1
http://heavy%20duty%203m%20double%20sided%20tape
http://www.amazon.com/Trading-Black-Velcro-Cable-Ties/dp/B00I9MWBEO/ref=sr_1_3?s=hi&ie=UTF8&qid=1459479190&sr=1-3&keywords=heavy+duty+velcro+straps
http://www.amazon.com/Leegoal-Nylon-Cable-Of100PCs-Black/dp/B005OK7P3G/ref=sr_1_15?s=hi&ie=UTF8&qid=1459479274&sr=1-15&keywords=heavy+duty+cable+ties
http://www.amazon.com/FatShark-Attitude-Headset-Trinity-Tracker/dp/B013UHWF7U/ref=sr_1_11/181-7642720-0028264?ie=UTF8&qid=1459478434&sr=8-11&keywords=fatshark+dominator+hd
http://www.hobbyking.com/hobbyking/store/__54822__OrangeRx_T_SIX_2_4GHz_DSM2_Compatible_6CH_Transmitter_w_10_Model_Memory_and_3_Pos_Switch_Mode_2_.html?gclid=CjwKEAjwlfO3BRDR4Pj_u-iO2U0SJAD88y1SN0YkajkHNHhWkkj6J0ZrLVts3Uq9007jfqY7M8rpRhoCPPfw_wcB
http://www.hobbyking.com/hobbyking/store/__18327__Turnigy_TQ4_4x6S_Lithium_Polymer_Battery_Pack_Charger_AU_Warehouse_.html
http://www.amazon.com/Vastar-Magnetic-Precision-Screwdriver-Electronics/dp/B015F734P0/ref=sr_1_1?m=A13PRKMVKLJGWH&s=merchant-items&ie=UTF8&qid=1459478695&sr=1-1&keywords=B00X60B0GY%7CB014KBIB3M%7CB015F734P0
http://microraptorcases.com/collections/fpv-racer-cases-backpacks/products/microraptor-pro-universal-transmitter-and-battery-backpack-for-mini-quads
http://www.eagleeyemetrics.com
http://www.Hooliganfpv.com
mailto:dsfx@mac.com
https://twitter.com/El7ias

